Mimicking Angiogenesis in vitro: Three-dimensional Co-culture of Vascular Endothelial Cells and Perivascular Cells in Collagen Type I Gels

Markus Auler1, 2, Lena Pitzler1, 2, Ernst Pöschl3, Zhigang Zhou3, 4 and Bent Brachvogel1, 2, *

1Medical Faculty, Department of Pediatrics and Adolescent Medicine, Experimental Neonatology, Cologne, Germany; 2Medical Faculty, Center for Biochemistry, University of Cologne, Cologne, Germany; 3Biomedical Research Centre, School of Biological Sciences, University of East Anglia, Norwich Research Park, Norwich, UK; 4Medical Faculty, University of East Anglia, Norwich Research Park, Norwich, UK
*For correspondence: bent.brachvogel@uni-koeln.de

[Abstract] Angiogenesis defines the process of formation of new vascular structures form existing blood vessels, involved during development, repair processes like wound healing but also linked to pathological changes. During angiogenic processes, endothelial cells build a vascular network and recruit perivascular cells to form mature, stable vessels. Endothelial cells and perivascular cells secret and assemble a vascular basement membrane and interact via close cell-cell contacts. To mimic these processes in vitro we have developed a versatile three-dimensional culture system where perivascular cells (PVC) are co-cultured with human umbilical cord vascular endothelial cells (HUVEC) in a collagen type I gel. This co-culture system can be used to determine biochemical and cellular processes during neoangiogenic events with a wide range of analyses options.

Keywords: Endothelial cells, Perivascular cells, Pericytes, Angiogenesis, Co-culture, Collagen gel

[Background] The coordinated interaction between endothelial and perivascular cells is essential to form a stable vascular network according to the local needs within a given tissue. Multiple molecular components contribute to the interactions but are still poorly understood. Various growth factors are needed to attract endothelial cells to sites of low oxygen concentrations and build new vessels that are then covered by perivascular cells. Both cell types interact to secrete a specialized extracellular matrix and stabilize the newly formed vessels. In the past multiple assays have been established to analyze vascular cell interaction and vessel-like network formation on two-dimensional matrigel substrates, but those are limited in providing information about initial steps of endothelial-perivascular cell interaction and vascular basement membrane formation in a three-dimensional microenvironment. In addition, well characterized perivascular cell suitable for culture experiments were missing.

We have previously isolated cells with perivascular characteristics, as they express pericyte-specific markers, produce and secrete extracellular matrix proteins and stimulate angiogenic processes in vivo (Brachvogel et al., 2005 and 2007). These cells were used to establish a co-culture system with human umbilical vein endothelial cells and study critical steps in neoangiogenesis upon interaction of the two cell types in a three-dimensional microenvironment (Pitzler et al., 2016; Zhou et al., 2016).
The co-cultures showed a superior activity to promote the formation endothelial tube formation and stabilization by perivascular cell recruitment and basement membrane formation. The culture system allows to monitor migration and interaction of vascular cells by time lapse microscopy and to study the deposition of basement membrane protein by immunofluorescence analysis. To quantify and isolate endothelial and perivascular cells from co-cultures immunomagnetic or flow cytometry sorting approaches can be used and cell type-specific global changes in mRNA and miRNA expression can be analyzed by subjecting isolated RNA from the separated cell populations to microarray analysis or RNA sequencing. Moreover, the effects of anti- and pro-angiogenic substances on endothelial-perivascular cell interaction can be analyzed in vitro. Hence, the three-dimensional culture protocol allows to study cellular, biochemical and transcripational events during neoangiogenesis and to characterize the pro- and anti-angiogenetic effects of molecules on endothelial perivascular cell interaction ex vivo.

Materials and Reagents

1. 15 ml tubes (Greiner Bio One International, catalog number: 188271)
2. 100 mm TC-treated cell culture dish (Corning, Falcon®, catalog number: 353003)
3. 1.5 ml tubes (SARSTEDT, catalog number: 72.690.001)
4. 24-well-plate (Corning, Costar®, catalog number: 3524)
5. T75-flask (VWR, catalog number: 734-0050)
6. 48-well-plate (Corning, Costar®, catalog number: 3548)
7. 10 ml syringe (BD, catalog number: 309604)
8. Sterile syringe filter with a 0.22 µm pore size (EMD Millipore, catalog number: SLGP033RB)
9. Disposable HSW FINE-JECK® needles (Henke Sass Wolf, catalog number: 4710004012)
10. Pipettes Gilson (10 µl, 20 µl, 100 µl, 1,000 µl, 5 ml)
11. Macro pipet tips (VWR, catalog number: 89368-994)
12. Microscope cover glasses: squares (Fisher Scientific, catalog number: S175222)
14. HUVEC (human umbilical cord vascular endothelial cell) (Lanza, catalog number: CC-2519 or self-isolation of HUVECs according to Baudin et al., 2007)
15. Isolated perivascular cells/pericytes (PVC) (see Note 1)
16. AnxA5-LacZ mice (Anxa5tm1Epo) (Brachvogel et al., 2003)
17. Collagenase type II (Worthington Biochemical, catalog number: LS004176)
18. DNase I recombinant (Roche Diagnostics, catalog number: 04536282001)
20. Propidium iodide (PI) (Thermo Fisher Scientific, Molecular Probes™, catalog number: P3566)
22. Fetal calf serum (FCS) (Biochrom, catalog number: S 0115)
23. Penicillin-streptomycin (P/S) (10,000 U/ml) (Thermo Fisher Scientific, Gibco™, catalog number: 15140122)
24. Gelatin from porcine skin (Sigma-Aldrich, catalog number: G2500)
25. Sodium bicarbonate (NaHCO₃) (EMD Millipore, catalog number: 1.6329.1000)
26. Rat tail type I collagen solution (Corning, catalog number: 354236)
27. Sodium hydroxide (NaOH) (VWR, catalog number: 28244.295)
29. Trypsin/EDTA (Biochrom, catalog number: L 2153)
30. Endothelial growth medium 2 (EGM2) (PromoCell, catalog number: C-22111)
31. Recombinant VEGF-A/Vascular endothelial growth factor (Biomol, catalog number: 94900)
32. Recombinant PDGF/Platelet-derived growth factor-BB (Biomol, catalog number: 94968)
33. Ascorbic acid phosphate (Sigma-Aldrich, catalog number: A8960-5G)
34. Methanol (VWR, catalog number: 20903.461)
35. Dimethyl sulfoxide (DMSO) (Sigma-Aldrich, catalog number: D8418-100ML)
36. Tween-20 (Sigma-Aldrich, catalog number: P1379-500ML)
37. Bovine serum albumin (BSA) (SERVA Electrophoresis, catalog number: 11930.03)
38. Anti-human CD31 (BD, BD Biosciences, catalog number: 555444)
39. Anti-NG2-proteoglycan (EMD Millipore, catalog number: AB5320)
40. Donkey-anti-rat Ig, Cy2 conjugated (Jackson ImmunoResearch, catalog number: 712-225-150)
41. Donkey, anti-rabbit Ig, Cy2 conjugated (Jackson ImmunoResearch, catalog number: 711-225-152)
42. Donkey, anti-rabbit Ig, Cy5 conjugated (Jackson ImmunoResearch, catalog number: 711-175-152)
43. Donkey, anti-goat Ig, Cy2 conjugated (Jackson ImmunoResearch, catalog number: 705-225-147)
44. Mounting solution
45. CFSE (Thermo Fisher Scientific, Molecular Probes™, catalog number: C1157)
46. SNARF-1 (Thermo Fisher Scientific, Molecular Probes™, catalog number: S22801)
47. MCDB-131 medium (Thermo Fisher Scientific, Gibco™, catalog number: 10372019)
48. Basic fibroblast growth factor (bFGF) (ReliaTech, catalog number: 300-003)
49. Epidermal growth factor (EGF) (Biomol, catalog number: 97052)
50. Insulin solution human (Sigma-Aldrich, catalog number: I9278)
51. Heparin
52. Hydrocortisone
53. 10x DMEM, 10x Dulbecco’s modified Eagle’s medium (Sigma-Aldrich, catalog number: D2429-100ML)
54. Sodium pyruvate (Thermo Fisher Scientific, Gibco™, catalog number: 11360070)
55. Trizma® base (Sigma-Aldrich, catalog number: T1503)
56. Sodium chloride (NaCl) (EMD Millipore, catalog number: 1064041000)
57. Autoclaved distilled H₂O
58. Proliferation medium (see Recipes)
59. PVC culture medium (see Recipes)
60. HUVEC culture medium (see Recipes)
61. 2x medium-mix (see Recipes)
62. Collagen solution (see Recipes)
63. Tris-buffered saline (TBS) (see Recipes)

Equipment

1. Centrifuge (Eppendorf, model: 5415 R)
2. Hemocytometer (LO-Laboroptik, model: Neubauer-Improved)
3. CO₂ cell incubator (Heraeus)
4. Centrifuge Labofuge (Heraeus Sepatech, model: Labofuge GL)
5. Autoclave
7. Axiovert 40 CFL (Zeiss, model: Axiovert 40 CFL)
8. Axioplan 2 (Zeiss, model: Axioplan 2)
9. Water bath (Köttermann)
10. Vortex mixer (Scientific Industries)
12. Fluorescence-activated cell sorting (MoFlow, Cytomation)
13. Biosafety cabinet LaminAir HB 2448 (Heraeus, model: LaminAir HB 2448)

Software

1. ImageJ (Fiji)

Procedure

A. Original protocol for pericyte isolation from meninges using AnxA5-LacZ mice
1. Prepare approximately 200 ml of 5% FCS-PBS and cool down 100 ml of 5% FCS-PBS on ice.
2. Isolate carefully the brain from 4-6 month old AnxA5-LacZ mice. Dissect the meninges under a stereomicroscope and transfer them into a 15 ml tube with 5% FCS-PBS on ice. Collect several meninges and then centrifuge the sample for five min at 400 x g at 4 °C.
3. Aspirate supernatant and dissolve pellet in 1.5-3.0 ml of 0.4% collagenase type II. Incubate sample for 60 min at 37 °C slightly shaking. Subsequently, centrifuge digested tissue for five min at 400 x g at room temperature.
4. Aspirate supernatant and resuspend in 1.5-3.0 ml of 2% trypsin/100 U DNAse I. Then, incubate digested tissue for 30 min at 37 °C slightly shaking. Next, centrifuge for five minutes at 400 x g at room temperature.

5. Resuspend cell pellet in 5% FCS-PBS and filter cell suspension through a 100 μm cell strainer. After that, centrifuge cell suspension for 5 min at 400 x g at room temperature.

6. Aspirate supernatant and resuspend cell pellet in 5% FCS-PBS. Determine cell number by using a hemocytometer, then dissolve 1 x 10^6 cells in 20 μl of 5% FCS-PBS and distribute 20 μl of the cell suspension into new 1.5 ml tubes. Add 20 μl of 2 mM fluorescein-di-(β-D-galactopyranoside) (FDG) to 20 μl cell suspension and incubate mix at 37 °C for 75 sec. Add 500 μl of ice-cold 5% FCS-PBS to the cells and incubate on ice in the dark for 3 h. Use a non-stained sample as control for cell sorting.

7. Centrifuge cell suspension for 5 min at 400 x g at RT and resuspend cell pellet in 500 μl of 5% FCS-PBS. To exclude dead cells, add propidium iodide (final concentration 1 μg/ml)

8. Sort stained cells by fluorescence-activated cell sorting (MoFlow, Cytomation) and collect propidium iodide negative and FDG positive cells. Next, plate 5 x 10^4 of PI negative/FDG positive cells per well in proliferation medium (see Recipes) on gelatin-coated 24-well-plate and store cells in a 5% CO2 humidity incubator at 37 °C. Change medium every second day and expanse isolated cells.

9. After initial expansion, the cells are cultured in DMEM with 10% FCS and 1% P/S. Cells should be further characterized by flow cytometry. Cells are positive for Sca-1, CD140b and α-SMA and negative for PECAM, CD45, CD34, F4/F80 and c-kit. Isolated Anxa5-LacZ(+) PVC from mouse meninges retain their perivascular cell phenotype and can be cultured without undergoing senescence for multiple passages (Brachvogel et al., 2007).

Note: An established and well characterized PVC cell line with superior angiogenic activity can be send to individual researcher upon request to perform coculture experiments with endothelial cells (Zhou et al., 2016). This eliminates the need to isolate the cells from mouse brain meninges.

B. Co-culture of PVCs and HUVECs in collagen type I gels

1. Dissolve 0.1 g of gelatin in 100 g of autoclaved distilled water (final concentration 0.1%) and autoclave the solution at 121 °C for 30 min. Then, coat 100 mm TC-treated cell culture dish with gelatin by adding 5 ml of 0.1% gelatin solution to the dish and distribute gelatin solution until the whole 100 mm TC-treated cell culture dish surface is fully covered. After at least two hours’ incubation at 37 °C, the residual gelatin solution is aspirated. Subsequently, dry dish at room temperature before use.

2. HUVECs are cultured in EGM2 culture medium (see Recipes) on gelatin-coated plates in a 5% CO2 humidity incubator at 37 °C. Cells are cultured until subconfluent (~80%) and further passaged (1:3 dilution). HUVEC are only used in early passages (passage 3-6). PVCs are cultured in DMEM with 10% FCS and 1% P/S (see Recipes) on T75-flasks or on 10 cm dishes and expand to about 80% confluency (see Note 2 and Figure 1).
3. Prepare 10 ml of 2x medium-mix (see Recipes). Therefore, dissolve 0.38 g of NaHCO₃ in 10 ml of autoclaved distilled water (concentration 0.45 M) and after dissolving sterile filter the solution. Then, mix 2 ml of 10x DMEM, 200 µl of 100x sodium pyruvate and 1 ml of prepared 0.45 M NaHCO₃ (final concentration 0.045 M) in 6.8 ml (final volume 10 ml) of autoclaved distilled H₂O. Solution should be cool on ice until use.

4. For 4 ml of collagen solution (see Recipes), mix 2 ml of 2x medium-mix, 800 µl FCS (final concentration 20%), 963 µl of 8.3 mg/ml rat tail type I collagen (see Note 3) (final concentration 2 mg/ml) and 23 µl of autoclaved distilled H₂O on ice. Finally, neutralize collagen type I gel solution with 214 µl of 0.1 N NaOH on ice and adjust pH of solution to 7.4. Store the prepared collagen solution on ice until usage.

5. Wash sub-confluent, cultured HUVECs and PVCs with 10 ml of PBS and detach cells with 1-2 ml trypsin/EDTA for 5 min at 37 °C. Add 9 ml of EGM2 culture medium to stop reaction and collect cells in a 15 ml tube.

6. Centrifuge cells for 5 min at 400 x g at room temperature (RT). Aspirate supernatant and resuspend cell pellets in 5 ml of EGM2 culture medium. Add 10 µl of each cell suspension into a hemocytometer to determine cell concentration.

7. For monoculture, transfer 6.25 x 10⁵ HUVECs or 1.25 x 10⁵ PVCs (see Note 4) in EGM2 medium in a new 15 ml tube. Mix 6.25 x 10⁵ HUVECs and 1.25 x 10⁵ PVCs for co-culture in 2 ml EGM2.
medium in a new 15 ml tube (Figure 2). Alternatively, different endothelial cells or perivascular cells can be used, but the relative ratio of cells need to adapted and tested. Technical duplicates or triplicates are highly recommended. Centrifuge cell suspensions at 400 \( x \) g for 5 min at RT.

8. Carefully remove all medium and resuspend cell pellets in 1 ml of collagen type I gel solution. Add 200 µl into each well of a 48-well plate and incubate for 60 min at 37 °C until solutions turns into gel. To increase homogeneity of gels, collagen type I gel solution with cells should be proper mixed and gel solution be uniformly disturbed in the well. Try to prevent uneven distribution of the solution by adding the gel solution directly in the center of the well and distribute by moving

---

**Figure 2. Workflow of the three-dimensional co-culture assay**

1. Prepare collagen solution
2. Trypsinize cells
3. Centrifuge cells
4. Determine cell concentration
5. Adjust cell number
6. Centrifuge cells
7. Resuspend cell pellets in 1 ml of collagen solution
8. Add 200 µl of gel/cell mix per well
9. After 60 min of gelling, add culture medium and incubate at 37 °C
10. Microscopic analysis of immunofluorescence staining

Take bright light images or continue with immunofluorescence staining (step C)
the 48-well plate carefully. To improve gelling, 48-well plates should be prewarmed in the incubator at 37 °C.

9. Check after 60 min whether a homogenous gel has formed. Otherwise incubate additional 30 min. After gelling, carefully add 400 µl EGM2 culture medium supplemented with 10 ng/ml VEGF, 10 ng/ml PDGF and 250 µg/ml ascorbic acid phosphate on top of each gel. Other growth factors or drugs may be added at this stage for different experimental conditions.

10. Incubate the gels for 3-6 days (see Note 6) in a 5% CO₂ humidity incubator and take images (Figure 3) or videos (3 images/h) every 24 h. We used 10 or 20x objectives to take images of networks (Zeiss SteREO Lumar.V12 or Zeiss Axiovert 40 CFL). Higher magnification can be used but the thickness of the gel can hinder the acquisition of images. EGM2 culture medium with supplements should be replaced every 48 h.

![Figure 3. Tube formation studies of mono and co-culture HUVECs in a three-dimensional collagen type I gel.](image)

C. Immunohistochemical detection of extracellular matrix and cellular proteins in 3D cultures

1. Wash gels twice with 600 µl of PBS (see Note 6).

2. Fix gels with 400 µl of 80% methanol/20% DMSO (Dent’s Fixative) for 30 min at RT.

3. Rehydrate gels with 600 µl of 50% methanol/PBS for 1 h at RT. Remove solution and add 600 µl of 20% methanol/PBS. Next, wash gel in 600 µl of PBS-T (PBS, 0.1% Tween-20) for 1 h at RT.
4. Aspirate solution and add 600 µl of 10% FCS, 5% BSA in PBS for 2-4 h at RT to block non-specific antibody-binding.

5. Remove carefully blocking solution and incubate gels with 150-300 µl of primary antibody diluted in blocking solution (10% FCS, 5% BSA in PBS), overnight at 4 °C lightly shaking on a rocking plate. Antibody dilutions should be tested empirically before.

6. Wash gels with 600 µl of TBS-T (0.1% Tween in TBS) for an hour. Repeat washing steps six times.

7. Incubate samples with 150-300 µl of fluorescent chromophore-conjugated, secondary antibodies in blocking solution for 2-16 h in the dark at RT.

8. Wash gels with 600 µl of TBS-T (0.1% Tween in TBS) for an hour. Then, repeat washing step six times.

9. Carefully remove gels from the wall of the well using a 27 G needle. Use a 5 ml macro pipet tips to transfer gels on slides. Add 50 µl of mounting solution on top of the gels and carefully mount samples with a glass coverslip.

10. Images are taken with Zeiss Axioplan 2 by using 5x and 63x objectives and adequate filter sets to get overview and close-up images, respectively. To visualize HUVECs in three-dimensional cultures gels can be immunostained with CD31 (Figures 4A and 4B) and PVCs can be immunostained with NG2-PG (Figure 4B) or α-SMA specific antibodies. The overview images of CD31+ HUVECs are used for tube formation analysis.

Figure 4. Endothelial tube formation of human umbilical cord vein endothelial cells (HUVEC) was induced upon co-coculturing with PVC. A. HUVECs are cultured either alone (mono culture) or in co-culture with PVC in a three-dimensional collagen I gel. After 6 days in culture, the three-dimensional collagen I gels were stained with human CD31 as described in Procedure C. Scale bars = 500 µM. B. Immunostainings of co-cultured HUVECs and PVCs...
using CD31 and NG2-proteglycan (NG2-PG) specific antibodies. Individual or as merged images with nuclear staining (DAPI) are shown. Scale bars = 100 µm.

D. Cell labelling with fluorescent dyes (CFSE, SNARF-1) for live cell tracking

1. Dissolve CFSE or SNARF-1 in DMSO to a final concentration of 5 mM at RT in the dark. After using fluorescent dyes, solution can be aliquoted and stored at -20 °C. For subsequent use of fluorescent dyes, thaw CFSE and SNARF-1 dye at RT in the dark. Freshly prepare 100 ml of 3% FCS-PBS solution. Store 25 ml at RT and cool the remaining 75 ml on ice for at least 30 min.

2. Detach HUVECs and PVCs as described (see step A3) and collect cells in 15 ml tubes. Determine cell number using a hemocytometer, then centrifuge cells for 5 min at 400 x g at RT.

3. Resuspend cell pellets in an appropriate amount of 3% FCS-PBS to a final concentration of 1 x 10^7 cells per 1 ml of 3% FCS-PBS. Do not use less than 50 µl of 3% FCS-PBS solution.

4. Prior to use, prepare 0.5 mM solutions of CFSE and SNARF-1 using PBS. Then, further dilute CFSE or SNARF-1 solutions (0.5 mM) using cell suspensions to a final concentration of 0.01 mM. Typically, 2 µl of 0.5 mM CFSE are added to 100 µl cell suspension. All following steps are performed in the dark avoiding light exposure.

5. Mix HUVECs and PVCs for 10 sec at maximum speed on a vortex mixer. Then, incubate cell suspensions for 10 min in a water bath, pre-heated to 37 °C, without shaking.

6. Add 5 ml of ice cold 3% FCS-PBS to stop the reaction and centrifuge cells for 5 min at 400 x g at 4 °C. Aspirate supernatant and resuspend pellets in 5 ml of ice cold 3% FCS-PBS. Centrifuge cells for 5 min at 400 x g at 4 °C. After centrifugation, aspirate supernatant and resuspend pellet again in 5 ml of ice cold 3% FCS-PBS. Centrifuge cell suspensions for additional 5 min at 400 x g at 4 °C.

7. Resuspend cells in an appropriate amount of EGM2 culture and proceed with step A4. Reduce light exposure during the subsequent steps and images (Figure 5) should be taken on an inverted microscope Eclipse TE2000-U (Nikon) or SteREO Lumar.V12 (Zeiss) over time. Here, a 20x objective was used for visualization. For each image, a phase contrast and fluorescence images in adequate channels (e.g., Fitc-channel for CFSE labelled cells) were taken. SNARF-1 is normally used for detecting initial tube formation (a few hours after gelling). Later SNARF-1 labelling is difficult to detect. This system can be used to track the recruitment of perivascular cells to the endothelial cells during initial angiogenesis steps.
Figure 5. Co-culture of human umbilical cord vein endothelial cells (HUVEC) and CFSE labelled perivascular cells (PVC) to track perivascular cells in three-dimensional condition. PVCs were labelled with CFSE as described in Procedure D and subsequently co-cocultured with HUVECs in a three-dimensional collagen type I gel. After 72 h in culture, phase contrast image and fluorescence images were taken with a 20x objective. The brightness and contrast of the CFSE fluorescent and merged image were adjusted for visualization. Scale bars = 100 µm.

Data analysis

1. The program ImageJ (Fiji) was used for image analysis.
2. Open image file of interest (File → Open → Select image).
3. Set scale. Choose ‘Arrow Tool’ in the toolbar and draw an arrow along the scale bar in the image. Next, click Analyze → Set Scale to open a new window, in which the known distance and unit of the length should be adjusted based on the distance and unit lengths acquired from the scale bar arrow. After, click ‘OK’.
4. Go to toolbar and double click on ‘Arrow Tool’ to open a window. Choose a color for the arrow and click ‘keep after adding to overlay’. Next, click ‘OK’.
5. Choose ‘Arrow Tool’ and draw an arrow along the tubes. Click Analyze → Measure (or STRG+M) to open a ‘Results’ window, which contains the length of this arrow. To add the arrow to the image, click Image → Overlay → Add Selection (or STRG+B).
6. Draw an arrow along the next tube and measure the lengths as described in step D5.
7. Once all the tubes have been measured, save the image with arrows (File → Save as → TIFF).
8. Transfer the data from the ‘Results’ window into an Excel spreadsheet and determine the average of all measured tube lengths. It is recommended to acquire measurements from two or three, different images.
**Notes**

1. Different endothelial cells (commercial providers) or perivascular cells isolated by various isolation procedures may be used for co-culture. In any case, cell numbers may have to be optimized for individual experiments.
2. 100% confluent cultures should not be used for this assay, as it affects tube formation.
3. Concentration of rat tail type I collagen can vary in different batches, volume have to be adjusted.
4. Cell numbers that have not be adjusted accordingly can affect results.
5. Include scale bar in each image for quantification.
6. Carefully remove supernatant from gel without touching. Pipetting, rather than aspiration, is recommended for this step.

**Recipes**

1. Proliferation medium  
   MCDB-131  
   5% FCS  
   10 ng/ml epidermal growth factor (EGF)  
   2 ng/ml basic fibroblast growth factor (bFGF)  
   5 µg/ml insulin  
   5 ng/ml platelet-derived growth factor-BB (PDGF-BB)
2. PVC culture medium (DMEM, 10% FCS, 1% P/S)  
   445 ml DMEM  
   50 ml FCS  
   5 ml P/S  
   Pre-warm medium before use at 37 °C
3. HUVEC culture medium (EGM2 with supplements)  
   500 ml basal medium  
   0.02 ml/ml FCS  
   5 ng/ml epidermal growth factor (EGF)  
   10 ng/ml basic fibroblast growth factor (bFGF)  
   20 ng/ml insulin-like growth factor (IGF)  
   0.5 ng/ml vascular endothelial growth factor (VEGF)  
   1 µg/ml ascorbic acid  
   22.5 µg/ml heparin  
   0.2 µg/ml hydrocortisone  
   *Note: Basal medium should be ordered with supplement pack which includes all above listed supplements in the right concentration. Only small aliquots should be prewarmed at 37 °C.*
4. 2x medium-mix (final volume 10 ml)
2 ml of 10x DMEM
0.2 ml of 100x sodium pyruvate
1 ml of 0.45 M NaHCO₃
6.8 ml of autoclaved distilled H₂O

5. Collagen solution (final volume 4 ml)
2 ml of 2x medium-mix
800 µl of FCS (final concentration 20%)
963 µl of 8.3 mg/ml rat tail type I collagen solution
214 µl of 0.1 N NaOH
23 µl of autoclaved distilled H₂O
Prepare solution on ice and keep it on ice until usage

6. Tris-bufferd saline (TBS), pH 7.4
150 mM NaCl
50 mM Tris-HCl

Acknowledgments

The three-dimensional co-culture assay was used in two recent publications (Pitzler et al., 2016; Zhou et al., 2016). The work is supported by Deutsche Forschungsgemeinschaft (DFG 2304/5-3, 2304/7-1, 2304/9-1).

References